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EPIC: Find the Treating Physician

Click on Patient Station and select the Admission Line.
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Results Review
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Click on Treatment Team.
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Click on any report to launch it, then click the back arrow at upper left to return to this index.

-
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You will see the list of contact info. Click on Web Paging to page the person (remember the pager number).
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EPIC: Image access

An interface exists between PACS and EPIC that allows clinicians to view images without exiting EPIC. A
hyperlink appears at the top of each imaging order when images are available.

g Chart Review (Last refresh: 2:48:36 PM)
I

SnapShot Encounters Lab Surg/Anes | Procedures | Meds  Notes/Trans ECG/ECHOQO  Other Orders | Media GoC Episodes Letters Consents | Admin Referrals

Chart Revi... | 3t Filters [ Preview - [ Refresh | = Select Al ElDeselectAll | Bl Review Selected | & Route
Review Flo__.

4 records match filters, all records loaded W Hide Cancelled T MRI T CT T US
Results Re...
Filters: Hide Cancelled
Date Test Status Order# 4=Back (¥ | A S B- B
X-RAY CHEST FRONTALAND LATERAL Final result
06/25/2015  X-RAY WRIST COMPLETE MINIMUM 3 V... Preliminary result 102969988 PACS Images
06/25/2015  X-RAY HAND 2 VIEWS - LEFT Preliminary result 102969994 Show images for X-RAY CHEST FRONTAL AND LATERAL
06/25/2015 X-RAY FOREARM 2 VIEWS - LEFT Preliminary result 102969987

Results | PAcs Link | X-RAY CHESTFRONTA

The screen layout is slightly different than Visage and the tools are limited but all images are available.

p5-Jun-2015 2:33:09 AM  JPEG(80)

At this time all UCSD clinicians also have access to Sectra directly. Some outside clinicians also have
access to images via iConnect, a web-based product.
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Visage PACS: Picture Archive System

VISAGE IMAGING®

Visage 7 Viewer FAQ
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Visage 7 FAQ- UCSD

* Where do | change my monitor configuration settings for viewing on a Visage 7 client?

0 To adjust the windows that allow for viewing within the Visage 7 dient,
navigate to the upper left-hand corner and choose File » Preferences»
Monitor Configuration. This will allow you to customize your monitors for
viewing, displaying the study browser, study navigator, and export.

How do | access priors for a patient?

O Patient priors can be accessed from the Study Navigator, or from the Thumbnail
Browser at the bottom of the viewer.

*  Will the prior reports be available and where do | find them?
Y Prior reports will have been migrated into the system just prior to go-live and can
be found by clicking on the Report Icon in the toolbar or the study navigator.

©  In addition, the impression of the report can be found by hovering over the report
icon in the study navigator.

* (an | customize my toolbar?

' Yes, you can right click in the empty space in the toolbar area and uncheck toolbars
that you do not want or check toolbars that are not currently shown. To save these
changes, right-click in an empty space in the toolbar section and select “Save
Toolbar Settings”. Note that the settings will be saved for that protocol only.

* What is a protocol? How do | change the protocol?

O The protocol on a Visage 7 client refers not only to the display of data, but also
incorporates the tools that will be available by default in the toolbar, certain
window-levels which may be applied to viewports, and whether the linking of
datasets is enabled by default. You will have more than one option for the loaded
protocol. Navigate to the top left of the screen and click on “Protocol®, then choose
a different protocol to load if needed.
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What is a layout? How do | change layouts?
o Alayout dictates the way images are displayed in the viewer. They are configured as part of

the hanging protocol. The user can change layouts by clicking on a different layout from the
layout toolbar. They n also be re-arranged by dicking and dragging them to a more
prominent place within the layout toolbar.

Adding to default layouts:

Default Lavouts Add to Default Layouts

Quadrant Mavigation Ramova from Default Layouts

The function of ‘Add to Default Layouts’ allows the user to quickly set a different layout as
their preference to load into next time they open up a similar exam. The system will
remember the |ast added default layout.

Anytime a change is made to the layout menu (setting a default, hiding, adding, or re-
arranging any layout), the user must right click again on any layout and hit “Save Layout
Preferences” for the changes to apply. Remember changes apply only to the Protocol they
were done for.

Can | aeate Keyboard shortouts? Can | map the keyboard shortcuts to a gaming mouse?
o Yes, select CNTRL+K to open the ‘Configure Keyboard Shortcuts Dialogue’. A user can map a

tool to a letter or combination of keys to create a keyboard shortcut and/or map spedfic
keys to 3 gaming mouse via the mouse GUI.

How do | link the series for a current study?
o Some protocols may link series within a study automatically upon loading. When series are

not linked, there are a few different ways they can be linked. You can use the linking tools
in the toolbar, selecting as the first option the ‘Automatically Link Viewers' button.

|'_':|'+;:| dutorialicaly Link Yiewers

Note, this button may be mapped to the ‘L’ key on the keyboard by default. This action
usually links all series of the same orientation together. {This function uses the DICOM tag
“Frame of Reference” and for some exams you may find series of the same orientation that
do not link with this tool due to different values of that tag). After doing so, you will notice
the Toggle Linking' icon in the toolbar is now a darker shade, indicating that linking is
active. Chicking this button will toggle linking off and on. If automatic linking is not desirable
or the series that you would like to link do not meet requirements of automatic linking, use
the “Link Scrolling” button to manually select and link the series, as desaribed below.
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*  How do | link a current exam to a prior study?

o Tolink series that do not have a defined anatomical correspondence, such as
current/priors, you can use one of two linking tools:

Use the link scrolling tool to link desired series at a desired position. Enable the tool, then
dick once in viewports to be linked. Then click the checkmark in the lower right-hand
commer of the last-clidked viewer. The desired series will now be linked.

o Automatically Link Viewers [Frames of Reference)

il ' i I . "
(Y~ Autarnatically Lirk Vigwers (Framas of Reference)
R A : : :

Using this tood links the series of the same orientation from current and prior studies by the
centers of their volumes. This is often a good starting point, and adjustments can easily bea
miade by holding down the shift key and scrolling one of the linked series to the same point
as the other, then after releasing the shift key, the series scroll together from the new
linking point. These tools do not have spedfic reguirements for the protoool, and work for
both 2D and MPR/3D viewers.

*  How do | know which series are being displayed and if | have viewed all images?
o There are various indicators in the lower-right hand cormers of the thumbnails that will
differ depending on the data.

Volumetric Data:
Volumetric data is shown with a single cube in the lower left corner of the thumbnail. This
means the thumbnail contains a single volume.

For volumetric data, a green border arcund a thumbnail indicates that this image setis
currently shown in the active viewer. Click a thumbmnail with a green border to highlight the
active viewer briefly.
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A preen triangle in the lover right corner of a thumbnail indicates that this dataset is shown in
one of the viewers on the screen.
il .'L""';.' n

A grey triangle in the lover right corner indicates that this dataset had been displayed in a
viewer at some point but has since been unloaded.

Multi-volume or non-volumetric Data:
A folder symbol in the bottom left indicates a non-volumetric stack of images is present.

(L ncalizers)

A cube and a folder symbol indicate that multiple volumes are present in the thumbnail, such as
a DW| series or In Phase/Opposed Phase series.
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A solid green triangle in the lower right corner indicates the dataset is currently on screen and all

mages within the stack have been viewed.
4

*Mote: A stack is considered a compilation of single 2D images, i.e., plain Films/statics in US are
single images independent of each other.

A hollow grey triangle in the lower right indicates the dataset was hung in the viewer, but not all
the volumes within the series have been viewed yet.

A solid grey triangle in the lower right corner indicates the dataset was at one point hung in the
viewer, and some slices within at least one of the volumes have been viewed.

*Mote: It is not necessary to scroll through every slice within the volume to have the indication that
the volumne has been fully viewed. The same applies to Ultrasound dips- the entire clip does not

need to play for it to be considered viewed.

o There is an option to set a preference, “Show waming if not all images have been viewed”
for the system to notify a user when all images in a study have not been viewed upon
closing the current session.

o There s a tool called “Show Unseen Images Warning” that can be manually triggered at any
time via tool palette or applying it to a keyboard shortout.

Show Unseen Images Warning
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This warning would include all images in the study, including lecalizers and non-diagnostic
series such as calibration images.

* (Once | make changes to my user profile will | have to set those features up again or will it save?
o Specific user preferences (W/L presets, Keyboard Shortcuts, and Tool Palate) will be saved

to the user profile and always follow the user, regardless of the workstation they are using.
Changes in font and icon sizes are stored for monitors of approximately the same size as
the monitor where this change was made. The only configurations that will NOT follow the
user to different workstations are monitor configuration.  Monitor configuration changes
will need to be set up once per workstation.

* How do | change the W/L presets? Can | create custom W)L presets?
o Select File>Preferences>WindowLevel Presets or select WindowLevel Presets from the

viewer controls (in bottom left-hand comer of viewport). Custom W/L presets can be
chosen for the modality for which you want to define a preset and a preset number.

o Preset numbers correspond to the NUMERIC (0-9) keyboard shortcuts that you can use to
select presets quickly while you are reading images. W/L presets cannot be mapped to
alphabetic letters.

*  How do | configure my tool palette?

o 3elect File=Preferences=Tool Palette. In the search filter box above the Available Tools list,
type the name or part of the name of the tool that you are looking for or soroll through the
list to find the desired tool.

o Select a tool and drag it onto the Tool Palette to the right. Flease note that moving 2 tool to
a bow that is already ocoupied by another tool will replace that tool.

o Select whether to show the tool palette, the viewer context menu, or both when you right-
click a viewer.

o Click the “Revert to System Defaults" button to reject any recent or previous assignments
or reassignments.

Click OK to confirm and dose the dialog boux.
I you want to remaove a tool, right dick on itin the grid and select ‘Remove’.

* How can | find a patient that | viewed finterpreted earlier today?
2 A user can find recently opened studies from the study browser, by dlicking the “Recent
Studies” tab. If this is not shown, click the “+* sign next to the Visage tab, and select
“Recent Studies”.
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How do | reset my viewer to start over?
0 CNTRL+ N will begin a new session. This is a configurable shortout, or alternatively go to
File*New Session. |f you have made annotations, you will be prompted to let you know that
continuing to reset will erase your annotations. You can proceed or cancel at that point.

Can | hide the toolbar?
o Yes, by dicking View>Auto Hide>Hide Toolbar.

Can | change the viewer text color?
o Yes, by going to File>Preferences>Properties> Text and Line Color for Prior Studies’.
Similar preferences exist for current and future studies as well.

How do | change font, toolbar, or thumbnail sizes?
o Byholding CNTRL + scrolling the scroll wheel while hovering over viewer text, toolbar, or
thumbnails. Saroll the mouse wheel up to increase text size and scroll down to decrease
text size.

How do | know if there are any additional studies in the archive?

o [ there are additional studies in an archive, Visage will prompt the user with a blue
hyperlink at the bottom of the study navigator which reads “Load additional studies from
Archive”. After clicking on the hyperlink, the user will have an option to import them to the
Visage cache from the archive.

What is the red folder icon in the corner of each viewer?

o The red folder icon provides a user with the access to the list of the series of all currenthy
loaded studies.

How do | turn off the patient information if it is covering the anatomy?
o Hit the space bar to toggle through the levels of verbosity, or you can use the “Toggle
Patie dy data” tool.

How do | anonymize images?

o Thespace bar is a quick way to hide DICOM overlays including patient demographics.
Toggle patient/study data tool hides patient demographics while preserving other overlays,
such as annotations and measurements, and crosshairs

o Privacy mode can be enabled via File > privacy mode to hide patient data but preserve the
overlays of technical factors.

0  De-identify from study browser if you need to create fully de-identified copy of the study.

UC San Diego Department of Radiology
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* (Can | export images to a PowerPoint?
o Screenshot > Save > Export as JPEG/PNG to folder.
¢ Once the image is in the export tab, a user can right click on the image from the export tab,
click copy, and then paste it into PowerPoint.
¢ The user can set a property for images to automatically have these copied to dipboard by
going to the property File: Preferences: Properties> General Configuration » Copy
Screenshot to clipboard.

¥ What is the difference between saving presentation states and secondary captures?

o Presentation state is a way to save attributes such as W/L, Rotate/Flip, and
annotations/measurements so that the study loads that way the next time someone loads
the study. Unlike the secondary captures, the Presentation State features can be applied
interactively — for example, the annotations may be hidden with a single click.

¢ Asecondary capture is a snapshot of a viewer or of multiple viewers. When creating the
snapshot, Visage captures exact pixels that are displayed to the user, including not only the
image(s) but also all text and graphic overlays. When such an image is displayed, the text
and graphics cannot be interactively hidden since a separate DICOM series will be saved as
a secondary capture.
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VISAGE IMAGING'

Visage 7 Worklist FAQ
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Visage 7 FAQ- UCSD

*  Where do | access the Visage 7 Worklist?
o Toaccess the worklist presets, simply click on the Worklist tab in the top right corner of the
application.

study Browser | Whaklisl

* How do | add in additional worklists to meet the needs of my workflow?

o Right dick on “New Preset” and choose “Select System Presets” from the options. From the
“Show or Hide Presets” menu, check off the worklists that you would like to subscribe to
and then they will appear as options on your preset toolbar.

OF Fem

'|ll M e
Nenrn

[wrau

SomdulediAnivsd
1 Fraracs

* How do | activate a specific preset?
o Simply dick on the preset that is needed at the time. The active preset will turn green when
enabled.

rrrogess ' © AllREadytofead
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* Can | combine multiple presets to create one [ist?
o Yes, if you dick the first preset button and then hold down the Cird key + click the second
preset, the two lists will turn green and be combined into one comprehensive [ist.

*  Can | further filter a system worklist?

o Wyou expand the drawer on the left-hand side of the worklist screen by clicking the ellipse
to the far left of the worklist presets, then you will be able to apply spedific exam status,
mizdality, timeframe, etc. filtars.

*  How do | reserve or assign a study to myself?
o [fyou double click a study on the worklist to open it for dictation, the study will
automatically be reserved to you. You also have the option to single left click the head icon
to reserve the study to yourself.

* How do| assign studies to others?
o Right dick on the study and select "Assign to...” from the drop-down menu. Select the
appropriate assignee from the list and choose OK.

*  How can | prevent my colleagues from opening and reporting on the same study that | currently
have open?

o The “Lock Studies for Reporting” button will be enabled by default. This button will appear
a darker shade of grey when depressed and should remain on while interpreting to alert
other radiclogists that you are actively reading that case if they were to try to open that
same study. A little lock icon will also appear just under the skip icon when you have the
study open for interpretation thereby presenting your colleagues with a visual indicator on
the worklist. Other radiologists would always be able to “View Only" or "View Only in New
Tab" so they will not be prevented from viewing that specdfic study.

B e ssics tor Hrpaing
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* (Can | rearrange or choose to hide certain columns on the worklist?
0 Yes, you can rearrange the columns by left clicking and dragging the column within your list
view to a new location. Also, you could right dick on one of the column headings and
choose to show) hide certain columns.

* Can | re-sort the list?
0 The list will be default sorted by priority and then timestamp, but you could left click on
any column heading to re-sort the list temporarily.

* How can | view 3 study that | do not intend to interpret at the time?
o Toassist with interruption workflow, right click on the study that you wish to view and not
report on, then choose “View Only in Mew Tab”. This will load the study in an additional tab
and will not interfere with a prior study you had loaded for reporting purposes.

® |5t possible to skip studies that | do not have responsibility to interpret?
0 Radiologists have the option to select to skip a @se on the worklist. To do so, dick on the
skip button which is in the “Skip/ Assignee” column and just to the right of the head icon.

The middle of the icon will tum red, and an ammow will appear once the skip has been
activated on a case.

* |sit possible to use an auto advance workflow?

o Ifyou would like to utilize an auto-loading workflow to advance to the next study on the
list, then right click on the first study, and choose "Auto Advance” from the menu. Double
click to load the first study and then once you dictate your report, the Visage 7 viewer will
close the session and will immediately open the next study from your worklist.

¥  How often does the worklist refresh?
0 The worklist will refresh automatically every 10 seconds.
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Tagging Studies for Conferences %

VISAGE TMAGING?

’

Select the “Schedule for
Conference” tool to open
the “Labels” dialog

Selecting the grey check box adds
this study to this conference on the
selected day.

Here you can also define your
favorite conferences by clicking on
the star.

1 drdr il aub, srniba.
Smon

Conferences with yellow stars are
favorites and can be filtered with the
“Show" pulldown menu in order to
reduce the conferences shown to
your maost relevant.

You can add a study comment to the
label by typing into the Study
Comment field and then clicking the
red check mark.

To create a new conference, click the
blue “New Conference” link. This will
open the “New Conference” dialog.
Here you can set up new private or
public conferences.

\. J

Copyright & Visage Imaging GmbH | V0L00-5ep 2021
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Sectra imaging is used for breast reporting. Training will be provided by the women’s imaging staff as
needed for residents and fellows. Below is a short summary of using Visage to view MRI breast images.

MR Mammography Vl;'AGrl TMAGING'

, : : \
Select MR Breast protocol and Dralw e Time-Density Analysis
switch to T-Series 1 layout ien\g:n:‘taeﬁ::age « Select a ROI tool from toolbar (or drop-down menu)

* Draw ROl in viewer
» Select ROI and right-click to open

[LF XY B (S

::““""’" ' Subtract baseline phase | Contextmenu :
[ uined from other images of a *  Select Time-Density Analysis

oAk time series
UCUNIL P U U] \

S SRS
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FERS U H R - S R S ]
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e
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w
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, Tool Palette Customization

?

VISAGE IMAGING;

Right-dlick in
viewer to open
Tool Palette
Choose

“Configure Tool

—

My s Preles

e i

Tl |l
:]lﬂl i " ‘ 11 L

T PR TRR I I

Lalimam
T SH

If ,Configure Tool
Palette” is not already
in your Tool Palette,
you can access the Tool
Palette configuration
dialog by choosing
File -+ Preferences -
Tool Palette

Be sure to odd tfor
the next time!

iRl

-/

© 2018 Visage Imaging

July 2022

-
Add Tools
Search for favorite

toals and drag them
into the Tool Palette

wl i
it 08

Re-arrange icans by
dragzing them into another
Tool Palette location

Re-arrange Tools

Remove Tools

Remove tools from the Tool
Palette by right-clicking and
selecting “Remove”

\,

H X f

A F'.r.zmci.-jr.zt

Help... &

v

WWW.visageimaging.com
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Keyboard Shortcut Customization V’ R
ISAGE, IMAGING

“Control K" opens up the
Keyboard Shortcut dialog.
Otherwise you could select
File -+ Praferences -+ Keyboard
Shortcuts

/Add Tools \

L MM K PN OROPE N
. o T
LRI R N R - I

Search for favorite tools and drag them into the Tool Palette.
Naote that you can define shortcuts as a single keystroke or
together with the “shift” or "alt" key.

AHART il
sabmria. Ok
T [T 8

© 2018 Visage Imaging WWW.Vis3geimaging.com V02,00 - Oct 2018
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Organize Layouts R
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o ™, fm change the default la*,'nut,-\l
Standard layouts may be thoase “Make Default”, This
hiddlen if certain conditions will always be the default for —
have not been met by the this protacal, and may overwrite
Inaded exam(s), a more complicated default rule, e laen e e
For example, comparison L2, default layouts that change Sl e
. depending on what exams are
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only one exam is loaded. 'L\' ./I y
Show hidden lzyouts
always by right cicking on ([ _ Y
any lajout, select “Show Hide Layout LR 2 femeap
Layout”, and choose the
layout to show.
\. ,/ Unused layouts can be hidden. il
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Customize Protocol Priority  §

ViSAGE TMAGING®

Example: Exam loads into CT Thin Slice Protocol, but user prefers
a basic CT Protocal

Mk Oy He s

bham:
A ETTIN 1

SRR Tl

T LeAen TR
T [iek|

© 2018 Visage Imaging
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(T Let on Tading
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Ve Al s fiadi]

| Rulie Larthage)
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disable a protocol by
unselecting the active
theckbax,

Change the priority by
dragging the desired protocol
above the highest priority
protocol.

For this example, drag the
CT protocol ahove the
CT Thin Slice protocol.

Click OK and type CTRL-n to
re-apply protocols to see the
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he Protocol Menu lists all

protocols that match the

|loaded data.

Ta change the priority of

these, select Protocol
Editing - Protocals...
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/ In the Pratocols Dialog, \ CT exams will now hang with the basic CT protacol
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Customize Window/Level Presets

?

VISAGE IMAGING;
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Key Images and Presentation States ?
VISAGE IMAGING:

F b R ¢ Il b=
Key Images//Screenshots: a1
Additional imagels) saved to
the study with the annotation
burmed in.
Fl'mﬂﬁlm S'HE: W ke,
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can be viewed in the original Fwan
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measurement in Visage, the application can -
create both a screenshot and/or a . —
P'I'EEHH-[IH stata, St L B Lotilr iz Dby L lukapl...
To 5et the default behavior you would select
the File menu > Preferences > Properties,
In the Properties dialog, search for “save” and
st the propertias ta Confirmation dialeg to
get a pop-up confirmation window.
Then choose “Save”. Uiy mlnmel
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Viewing X-Ray/US

Visace TMAGING:
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/| | Configure Tool Palette:

Choose
File -3 Preferences -3 Tool Pafette
and drag respective tool from list
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Viewing CT/MR ’
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] Make a screenshot
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Send screenshots to
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Keyhoard Shortcut Customization ’ |
VISAGE TMAGING

“Contral K" opens up the
Keyboard Shortcut dialog,
Otherwise you could select
File -+ Preferences - Keyhoard
Shortouts

/Add Tools \

A% AHPEKRBESHRTP NN

. i [T
"T‘ 1 Y ='|'.

Search for favorite tools and drag them into the Tool Palette,
Note that you can define shortcuts as a single keystroke or
together with the “shift” or “alt" key.
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Organize Layouts |
VisAGE TMAGING:
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/—\ /11: change the default la*,'nut,-\n 9 e
Standard layouts may be choose "Make Default”, This | |ESESRERARIHIREN
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layouts are often hidden if P Eluad o
only ane exam is loaded. 'L\' ./I y
Show hidden layouts
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Customize Protocol Priority ’

VisaGE TMAGING'

Example: Exam loads into CT Thin Slice Protocol, but user prefers

3 basic CT Protocol
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disable a protocol by
unselecting the active
theckbox,

Change the priority by
dragging the desired protocol
abaove the highest priority
protocal.

For this example, drag the
CT protocol ahove the
CT Thin Slice protocol.

Click OK and type CTRL-n to
re-apply protocols to see the
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he Protocol Menu lists all

|loaded data.
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Editing - Protocoks...

J

/ In the Protocols Dialog, \ CT exams will now hang with the basic CT protocol
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Customize Window/Level Presets

?

ViSaGr IMAGING;

Open W/L
Preset Dialog

-

Open the Window/Level preset
dizlog by clicking on the white
triangle next to the W/L values
in'the Viewer Control Menu
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select menu option
File -+ Preferences -

K Window,Lavel Presets...
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“Copy values from active

viewer" to update the
praset
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type in the new Window

\\ and Level values /
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Create W/L Preset
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To create a new
Window/Level Presat,
select the presat number,
enter the name for the new
preset, and enter the
Window and Level values,

The new preset can be
applied by its respective
shartcut (2.2 “6%)
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Automatic Linking Tool ’
VisaG: IwAGING'

( \

The “Automatic Linking" tool will link all series that have the same
DICOM frame of reference.

* It vall only link series within a single study
* It will link the matching series for scrolling, zooming, and panning

* Inthis example, the axial thin slice soft tissue, thick slice soft
tissue, and lung window will be linked to each other in the
current exam as well as in the prior exam

Notice that the “Toggle Linking” button is enabled after using the
*Automatic Linking" tool.

* Disable this button to temporarily turn off linking

Copyright © Visage Imaging WWW.VISageImaging.com V01,00 - Mar 2018
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M*MODAL FLUENCY FOR IMAGING REPORTING

IF INTEGRATION IS NOT OPERATING AS EXPECTED, PLEASE
ENSURE THAT THE SETTING IS CORRECT.

>, %y Settings >

Client Login Settings

The Visage Auto Launch Server allows you to start and control a thin

| 1 client session from your browser.
Server Name: ‘visage.ucsd.edu VJ

[[] Start Auto Launch Server when | log into the system.

User Name: inhpODF’ ‘

P d ] I Run Auto Launch Server (server is currently running) I
asswora.
§ Gr.

Language: English v

O Integrated Windows Authentication

Example: 192,168.2.0/9% 192.168.0.0/255.255.0.0, 10.*.*.*

Version: 7.1.17 (Build 3596) Login Cancel a 4
A 6 ) 242PM

Cancel

i Fluency

ad.ucsd.edu
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When logging into Visage on a designated reading station (DS), Fluency will auto launch, but will not
auto log you in. You can independently launch Fluency on other hospital computers or via the clinical
web portal (cwp).

Application opens to default tab = “Active Jobs” which displays the number of currently active jobs for
the user. Active jobs are considered jobs started, but not yet signed and includes jobs in the following
states:

Draft (Suspended)
Corrected
Resident Assigned

t
"1 Fluency for Imaging Reporting _ O %

Active Jobs I Assigned Pools I Completed Jobs I Scratchpad Jobs I Orders List I Critical Findings: UNKNOWVN, 99999 /"

Search | Q| ¥ Advanced search

All active jobs: 2 Drafts: 2 Corrected: 0 Assigned tome: 0 Assigned byme: 0 [

|| Launch Patient Accession RIS Status Job State Prev. Author(s) Assigned Author
ZZTEST, TEST |HUMPHREY VISUAL FIELD - OD - | 50873385 &2 Available 1712020 3:32 | UNKNOWN, 99999 UNKNOWN, 99999
(] O D N 30000005 RIGHT EYE B/20/2018 10:19 | Routine PM
G)J (UCSD Prod IR -EYE A Draft
lzzuer)
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Set up Fluency

Fluency Settings
To access the Fluency Settings and user preferences, click
the settings icon (Doctor with Stethoscope) from the toolbar

Db status: ggg b
e Voice Edit- .

Keep Fluency on Top

#  Microphone Wizard

f Edit My Vocabulary

J _ Update Preferences I

A_Manage My Templates
. Radimetrics Patient View

' <V Send Feedback

() Help Documents
About

Fluency Microphone Wizard

Recommended to run once if you are in a new environment.
It ensures that the microphone is connected and receiving
audio at the appropriate audio level. The wizard also records
the user’s dictation to improve speech recognition.

e To access the wizard, click on the Fluency Settings
icon and click Microphone Wizard from the drop
down menu.

e Hold down the Record button and read the available
text. Speak as you normally would during a dictation.
The audio level will be displayed as the recording
occurs.

Microphone Calibration = || = | 2=
Adjust your microphone

Turn on the microphone and read the following text:

Troubleshooting

e General setting — Can set auto save frequency time
period

e Change application Theme: dark(night mode) and
light(standard)

e Text Editor settings — Editor skin

. L. . L. X @ Record I Cancel
Click on the ‘Finish Wizard’ button when finished reading
text.
Update Preferences
Tools are available to customize Fluency properties Author specity .
Auto save frequency [ | ©

General

July 2022
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https://hs-mmodal.ucsd.edu/ClinicalWorkflow/MModalServices/Web/userPrefs.html#tabs-7
https://hs-mmodal.ucsd.edu/ClinicalWorkflow/MModalServices/Web/userPrefs.html#tabs-8
https://hs-mmodal.ucsd.edu/ClinicalWorkflow/MModalServices/Web/userPrefs.html#tabs-10
https://hs-mmodal.ucsd.edu/ClinicalWorkflow/MModalServices/Web/userPrefs.html#tabs-11

e Update user settings — There are a few settings that
requires you to close fluency and re-log in.

e Recording Device — Set dictation for “Push To Talk” or
“Toggle”

e MModal Scout - Can launch reporting analytics
module from Fluency. You will need to enter your
username and password the first time you use this
tool.

« Match app. theme

Editor style

Philips SpeechMike
Record button behavior in Voice-edit mode
Hold To Talk + Toggle To Talk
Record button behavior in Narrative mode

+ Hold To Talk Toggle To Talk

General Scout

Critical Findings Username

Device nhp007@ucsd

Editor
Password
SENS

Fleomlions Joossssssnss |

Scout Open patient in M*Modal Scoul

PACS ’

RIS
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Reporting Window and Toolbar

Dashboard

The dashboard will display a count of jobs applicable for the
current user. Clicking on the return to job list will close the
current dictation and return the user to the active jobs list.
The user will be prompted if there are unsaved changes to
the current report.

( Return to jobs list

Save/Assign/Sign
e Save will save a draft version.

e Residents will assign reports to either a person or a
pool depending on assigned rotation. Pools were
created to allow multiple supervising radiologists to
view signed reports by residents and fellows.

e Fellows working as unsupervised radiologists will sign
reports.

N A e B

Sign Assign Reject Save drait

Formatting tools
e Common edit tools of cut, copy, undo, etc.

e Tokens are place holders for data to be inserted into
the report from external systems (e.g. and order)

Delete report
Once a report is signed, it cannot be deleted. Only draft
versions of reports will be deleted.

S EXARBIUMAY
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Fluency reporting

Exams

Displays a list of reportable exams for the patient
in context. The main exam that was launched for
dictation will be under PRIMARY EXAM. Other

v Exams

reportable/linkable exams will be displayed CT -CT CHEST W/O CONTRAST
ASSOCIABLE EXAMS with checkboxes. Prior A
relevant studies will also be listed. You can view 8/4/2020 11:19 am

those reports, as well as the author and date

signed, Also, you can copy relevant data to paste
into current report. I XR - X-RAY ANKLE 2 VIEWS - LEFT
Acc# 70021572

Linking studies 4/21/2021 2:50 pm

To associate another accession number with the I unknown - X-RAY ABDOMEN 2
main exam, click on the corresponding checkbox.
A prompt will be displayed when attempting to
associate an exam from a different modality or an
exam outside of a 4 hour window of the main
exam. Once a preliminary or final report is sent,
and unlinking is not possible.

TEMPLATES

Templates

Available templates for the exam loaded for v Templates
dictation will be displayed in the templates 1. System Default

section. A template often serves as the starting
point for a new document and may contain
sections, subsections, fields and tokens, each
possibly containing text. Fluency supports both
user templates and system templates. User
templates will override system templates.

2. CHEST CT WITH

- |

. BLANK VOICE EDIT TEMPLATE

. BLANK NARRATIVE TEMPLATE
.ChestCT 71250 HRCT
.ChestCT 71250 Noncon

. Chest CT 71260 With IV

. Chest CT 71270 With and Without

[

[ ) I &N

If multiple templates match the current exam, the
highest ranking (or oldest) template will be
chosen by default. Additional templates will be
displayed in the Templates window based on
match of Modality and Body Part and/or | |
Procedure code.

(o))

0 ~

Note: After selecting a template, it is possible to
hide/minimize the template section by clicking
on the TEMPLATES header. This will leave more
room for the other content on the right side of
the document. This setting will be remembered
between dictations.
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Find a Template

If you want to use a template other than any that
are displayed by default (e.g. a template
belonging to another user), you can click on the
Find Template link. The Find Template window
will appear.

= Fluency Reporting - Find Template

TEMPLATE NAME

OWNER

[ ANy -
d

BODY PART
||| U~

Reset | Search

PETWCT - SKULL TO MID-THIGH

Template Name

Click on drop down to
select Template Owner

Template Preview

- —————————+—»
Find Template

EXAM DESCRIPTION:

[<Procedura Description>] [<Completed Time>]

CLINICAL HISTORY:

m

fter injection of [] mCi of 18F-2-fluoro-2-deoxyglucose (FDG) and a 1 hour
ptake period, a multi-bed 3D acquisition with low mA CT attenuation correction ]
was performed from the head to the upper thighs. [A diagnostic quality CT with
contrast of the thorax, abdomen and pelvis was performed just prior to the PET

acquisition]. The plasma glucose was [Img/dL.

Attenuation correction CT radiation dose information:

|=| Fluency Reporting - Find Template

TEMPLATE NAME

OWNER

|| AL USER TEMPLATES ~
«««««« v B0DY PART
[aLL ~ A ~|

a
9
@
@
P
<]
z
fi
o
<]
]

CT UROGRAM 2012 =

i

Find Template

EXAM DESCRIPTION:

CLINICAL HISTORY: =]

o 1) Select a Template to copy.
ECHNIQUE:
A CT scan of the head was performed with 2 mm contiguous axial slices from

the foramen magnum to the skull vertex without the use of intravenous
contrast.]

A contrast-enhanced helical CT scan was performed with contiguous axial slices
at [2] mm collimation and [0.5 mm] spanning from the aortic
arch to the skull base (Neck) and from the foramen magnum to the skull vertex
(Head) after the uneventful bolus injection of 100 ml of Omnipaque 350
intravenous contrast. The axial data set was reformatted in the coronal,
oblique, and sagittal planes. 30 angiographic reconstructions were done on an
independent workstation.]

COMPARISON: =

2) Click to check the box next to COPY

TO MY TEMPLATES

1. Enter a Template name. The name must be
unique. The name can be used as a voice
command to launch the template. Find a
system template user specific template,
create from draft or “copy to my templates.”
Will copy over procedure codes and/or body
part rules as original template. Recommend
as first time users. When working more with
attending radiologists, specific templates
may be required by section chiefs. Your
personal templates will override system
templates.

Template Editor

Template Name:

3) Click Insert

July 2022
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2. Insert/Modify the template content — E' e E e
template content can be added by typing or
using the microphone as if you’re in Voice o B

Edit mode 0 Edit My Vocabulary
.~ \pdate Preferences

[} Manage My Templates
@ Radimetrics Pabient View
% Send Feedback

e &8 Help Documents o

about

3.1 Inserting Tokens — tokens are place holders
for data to be inserted into the report from
external systems (e.g. and order).

To insert a token, click on the Insert Token
icon, select the token from a list and click
Submit.

3.2 Adding Simple Fields — to insert a simple

. . . Examination Performed:
field, type an opening and closing bracket =

anywhere in the template. They can be [D
navigated to by using the FF/RW keys on the Clinical History:
microphone or by issuing the NEXT FIELD or None]
PREVIOUS FIELD voice command.

Comparison:

3.3 Other formatting options: There are other
formatting options in the toolbar which can
be used to modify the look and feel of the -
document template. Bulleted and
Numbered Lists can also be inserted in a
report template.

EEXABRBIUMAY

Note: When the final message is sent via
HL7, the formatting will be stripped in most

cases
4 Associate the Template: Templates can be Template Association: < jio C Procedure Code

associated with specific modalities and or Select the Hodalties Body Parts for thie template

body parts or with specific procedure codes. Body Part Al

This will make it easy to create, for example, Sten ~ [camomc -

n n MAMMO = EXTREMITIES
a "global" CT template or a global CHEST M1 HEAD/NECK i
template. SPINE. ‘

WHOLE BODY
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5.1 Click on the Modality / Body part checkbox to
associate with a specific modalities and/or
body parts. Hold down the CTRL key to
select multiple entries from the modality and
or body part lists.

Template Association: * Modality / Body Part

™ procedure Code

Select the Modalities/Body Parts for this template

Modality  H Al Body Part

WAl

5.2 To select all entries, click on the All checkbox
for the corresponding entries

5.3 Click on the Procedure Code checkbox to
associate with a specific modalities and/or
body parts

Click on the Procedure Code checkbox to
associate with a specific modalities and/or body
parts

Template Association: ™ Modality / Body Part

|"’= Procedure Code |

-
Procedure Codes for this Template (5t least one code is required)
Procedure Code Description

71030 undefined XR

£

4

(e = T

CHEST

5.4 Click on the + icon under the procedure
codes section.

Template Association: ™ Modality / Body Part

= Procedure Code

Procedure Codes for this Template (at least one code is required)
Procedure Code Description

71030 undefined

Body Part

CHEST x

5.5 In the Add Exam Code to Template dialog,
use the filter options to search for a specific
procedure code and click the Search button.

|| procesurevese | acuon |
Z” Search I

CH 1v

KNEE 3VR

FINGER R

USBR

DMAMMSC

-

to the list.

CH 2v r -
5.6 Click the Submit button. The window will
close and the procedure codes will be added ONE [

-

5.7 To remove a procedure code, click on the [x]
button next to a procedure code.

5.8 Save the template by clicking on the Save
button or Cancel to cancel changes

| Cancel |

faultDacumentMadal ;I

 —
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To Edit an existing Template

e Locate the template in the list of Personal
Templates. Enter in a name or partial
name of a filter or the associated
procedure code to narrow the search.

e Select the Edit button for the template.

° The Template Editor window will
appear. From here you can edit the
template information. Note: The
template base cannot be modified.

MACROS

Macros

Macros are snippets of text, either a series of
words, a sentence or multiple sentences that can
be inserted into the document as part of the
reporting process through manual selection
within the macro list. Macros can be created at
the user level or the system level.

Available macros will be displayed in the Macros
section and will display a list of available Macros
for that specific user. Macros can be inserted
into the report as needed. Users have the option
to Create, Edit, or Delete a Macro from the
interface.

Note: The Macros section will only be displayed
while in Voice Edit mode.

Note: After selecting a macro, it is possible to
hide/minimize the macros section by clicking on
the MACROS header. This will leave more room
for the other content on the right side of the
document. This setting will be remembered
between dictations.

MACROS

AVAILABLE MACROS

1. ATTENDING REVIEVWED STATEMENT

2. CTRM COMMUNICATION

3. DISCUSSED COPY

4. DISCUSSED WITH

5. RED RESULT READBACK COMPLETED
6. YELLOW RESULT NOTIFICATION

Find | Create | Edit | Delete | Manage
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Create a Macro
To create a macro, perform the following steps:

e Click on the 'Create Macro' text. A
floating window titled Macro Editor will
display. Any text selected in the editor
will be carried over into the macro editor.

e Enter the Macro Name. This name will
also be used as a voice command for
inserting the macro: INSERT
<MACRO_NAME>. The name must be
unique and once it is created, it cannot be
changed.

e Enter or exit the content of the Macro.
The same voice and keyboard commands
that are used when doing a dictation can
be used in this window.

e Optionally select Modalities and/or Body
Parts to associate with the Macro. This
will limit the macro from displaying in the
list for matching exams.

e Click Save to save the macro or Cancel to
exit without saving.

Note: If a modality or body part was not
selected, the Macro will display in the Macro list
for every exam launched in Fluency.

MACROS

AVAILABLE MACROS

Eind @Edit | Deletz | Manage

B ———— ]

Macro Name | Save Cancell
o) ] | [ o]« o] [

Optionally select Modalities and/or

Body Parts to associate with the
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Edit a Macro
To edit a macro, perform the following steps:

e Click on the 'Edit Macro' text. A floating
window titled Macro Editor will display
populated with the existing Macro
information.

e Edit the text of the Macro or select/edit
the Modality and/or Body Part.

Note: The name of the macro cannot be
changed once it is created.

e Click Save to save the macro or Cancel to
exit without saving.

MACROS

AVAILABLE MACRODS

1. ATTENDING REVIEWED STATEMENT
2. CTRM COMMUNICATION

3. DISCUSSED COPY

5. RED RESULT READBACK COMPLETED
6. TRAUMA

7. YELLOW RESULT NOTIFICATION

Find | Create | T Delete | Manage

Find a Macro

Similar to Find a Template, if you want to insert a
macro that does not display by default (e.g. a
macro belonging to another user), you can click
on the Find Macro link (or FIND MACRO voice
command). The Find Macro window will appear.

By default, the window will show you macros
belonging to you matching the same modality as
the exam you are dictating. The following search
items can be modified:

e Macro Name (partial matches allowed)

e Owner: select a specific user, all users,

system level or all macros
e Modality and Body Part

Enter your search information and click the
Search button. The list will populate with any
macros that match your search criteria. Clicking
on the macro name will display a preview of that
macro.

.
=) Fluency Reporting - Find

Find Macro

MACRO NAME

3D volume-rendered MIP reformations were obtained on a separate standalone

ge processing workstation and submitted for interpretation.
OWNER

vy e
MODALITY BODY PART

[ALL | A ~|
Reset Search
Click on drop

= down to select
Macro Owner

1 FRACTURE NEG
1-5T MRI BRAIN WO TECHNIQUE
2

D

3D ADDENDUM FOR OTHERS

3D COPY

| ||20 mAciNG

3D IMAGING COPY

3D IMAGING COPY

30 IMPAX

30 POST-PROCESSING
AFELLOW REVIEWED STATEMENT
AAAGREE

AACPT FOR ONE -

Macro Name

M coPY TO MY MACROS Macro Preview Insert
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When a macro is selected, a checkbox in the
lower right hand corner may appear giving you
the following options:

e |f the macro belongs to another user, you
have the option to copy this macro to
your personal macro list.

e |f the macro belongs to you, you have the
option to update the association of that
template so it will match the current
exam you are dictating.

Click the Insert button to insert the macro into
the current report.

MACRO NAME
OWNER
[ Any |

MODALITY BODY PART

JALL =] [AL |
Reset Search
1FRACTURE NEG

1-5T MRI BRAIN WO TECHNIQUE =
2

3D ADDENDUM FOR OTHERS
3D COPY

bl |30 IMAGING

3D IMAGING COPY

il |30 IMAGING COPY

3D IMPAX

3D POST-PROCESSING

A FELLOW REVIEWED STATEMENT
AAACREE

AR GPT FOR ONE 52

M ¥ copy 10 my mAcROS

= Fluency Reporting - Find i

3D volume-rendered MIP reformations were obtained on a separate standalone
image processing workstation and submitted for interpretation.

1) Select a Macro to copy

—

2) Click to check the box next to
COPY TO MY MACROS

3) Click Insert

Delete a Macro

To delete a macro, perform the following steps:

e Select one of the macros from the list.

e Click on the 'Delete Macro' text. A
message box will display confirming that
the selected Macro should be deleted.

e Click Yes to delete the macro or No to
cancel without deleting.

Note: This option cannot be undone.

Note: Fluency users do not have the
permission to delete system level
macros.

Fluency Message

Are you sure you want to delete the
macro:test?

7. YELLOW RESULT NOTIFICATION
Find | crmse | g | [T snace

1) Highlight Macro you want to
delete

Find Template Creste templste from draft

MACROS

AVAILABLE MACROS

1. ATTENDING REVIEWED STATEMENT
2. CTRM COMMUNICATION

3. DISCUSSED COPY

4. DISCUSSED WITH

5_RED RESULT READBACK COMPLETED

2) Click Delete
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Manage Macros

Users can manage their personal macros
similar to editing their personal templates. To
manage macros, follow these steps:
e Click on the Manage link in the macros
area.
e The personal Macro Manager will
appear
e Every personal macro will be
displayed, 15 per page
e Click the Edit button on a specific row
to display the Macro Editor
e Click the Delete button on a specific
row
to delete the macro

Fuuency Reparting : Persanal Macso Manager

Fluency Reporting :: Personal Macro Manager

Inserting a Macro into a report

To insert a macro into a report, move the
cursor to the position of the report where the
macro is to be inserted (this can be done with
the mouse, keyboard or voice commands).
There are three options to insert a macro:
e Double click on the macro in the list
e Insert using a voice command: INSERT
<MACRO_NAME>
e Insert using the macro index: INSERT
MACRO ONE which corresponds to the
number index of the macro

VOCABULARY

Excluded Words

Ability to specify words that should not be
included in the report.

To exclude a word, perform the following
steps:

Select the Excluded Words radio button and
click Add.
e Type the word that you do not wish to
see in the dictation.
Click OK.

Dictionary
" Addedwords (* Excludedwords (" Replacement rules

=I=if=]

[sezrcn
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Replacement Rules
Ability to create a collection of

words or phrases that will be fjﬂﬂmw N N =
. Added words Excluded words ¢ Replacement rules
used to substitute the spoken ==
form. M[’j'alwd I:éﬂiﬂ [ inherted from [ Add i Trsin |
millimeter mm Edit |
SeIeCt the Replacement RUIeS Tgfsﬂgim mmd&lﬁom\aSan Di... Delete I

radio button and click Add.

e Enter the original text
into the Original Word
field (ex: cabbage)

e Enter the replacement
text into the Replace
With Field (ex: CABG)

Click Save.

Content Highlighting
Content in Fluency editor window when creating/editing a report is color coded to assist in the

display of the report. The following color codes are supported:

placeholders for data pulled in from external systems, such as
data from the RIS Order.

Token Content Content added by tokens is highlighted in purple. Tokens are
Field Content

Voice Enabled Fields are highlighted in teal.

Template / Macro Content | Content that was added as part of the template or added as part
of a macro will be rendered in grey as a visual indicator that this
information does not need to be checked again for errors.

Dictated / Edited Content Any content edited by the current user either by typing or dictating
will be rendered in black (exact color depends on the skin being
applied)

MRN: D1000 DOB: 9/27/1957 SEX: M

CELT: |»|~-_

Template / Macro Content

Field Content
Dictated/Typed Content

Transcription Edits
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Create Critical Findings :

MACRO NAME

e Currently use macros inserted into I |
impression section. 1 owner
e 2001 EPIC — Findings that are | SYSTEM MACROS ONLY v
potentially immediately life- MODALITY BODY PART
. B AL v| [ALL v
threatening. | V1] V]
Examples include: |
. Reset Search
pneumothorax, Ischemic J Q
bowel, Intracerebral | [ooo ADDENDUM DOSE
h h 000 ADDENDUM EXAM DESCRIPTION A
emorrhage. | |2001EPIC
You MUST phone and notify %gg;‘;ﬁ:ﬂﬂ
the ordering Physician ASAP. 2002 VERBAL
— Findi | |2003EPIC
: me:lmgs that'c.ould 5003 VERBAL
result in mortality or significant #  |ABBREVIATED MRI FOR HCC SURVEIL
ADDENDUM DOPPLER

morbidity if not appropriately
treated urgently.
Examples include: Intra-
abdominal abscess Impending
pathological hip fracture.

. — Findings that could

result in mortality or significant
morbidity if not appropriately
treated, but are not immediately
life-threatening or urgent.

Text within the macro may be edited after
insertion into the report.

Critical Results: Significant findings delineated above were seen at
on and had already been documented in Epic by
the Referring Provider. CTRM:2001:epic.

Line item at the end of each macro
statement MUST NOT BE MODIFIED OR
DELETED. The CTRM: 200x signals the Provider § CTRM:2001:epic.
correct information is sent over to EPIC in
the correct format for clinician notification.
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Voice Edit Commands

Clicking on Question Mark Icon will give you a list of Voice Edit commands that Fluency utilizes.

Job status: Draft r)

Dictation Mode: Voice Ec

Fluency Toolbar and their voice commands

il Fluency for Imaging Feporting

AECCE

&) o] s 4 [ o] 5o 1]

| ?| ...| =
=

1=

sl@ 1

1.) Click to save as draft [Voice Command: SAVE DRAFT]

2.) Click Sign report [Voice Command: SIGN REPORT]

3.) Click to assign this report [Voice Command: ASSIGN REPORT]

4.) Click to reject a report [Voice Command: REJECT REPORT]

5.) Click to prelim a report [Voice Command: PRELIM REPORT]

6.) Click to preview report [Voice Command: PREVIEW REPORT]

7.) Click to undo [Voice Command: UNDO THAT]

8.) Click to change font size (7 different sizes)

9.) Click to insert a token [Voice Command: INSERT TOKEN] Note: Two tokens cannot be inserted back
to back without a space between them.

10.) Cut — Ability to remove selected text from the current location and place it on the workstation’s
‘clipboard’ for pasting into a new location.

11.) Copy — Ability to copy selected text from the current location and place it on the workstation’s
‘clipboard’ for pasting into a new location.

12.) Paste — ability to paste text stored on the workstation’s ‘clipboard’ into a new location

13.) Bold [Voice Command: BOLD SELECTION]

14.)  Italic [Voice Command: ITALICIZE SELECTION]

15.)  Underline [Voice Command: UNDERLINE SELECTION]

16.) Add comment

17.) New Subsection [Voice Command: NEW SUBSECTION]

18.)  Click to create a bulleted list [Voice Command: NEW LIST; NEXT ITEM]

19.) Click to create an ordered list [Voice Command: ITEM NUMBER ONE, ...; NEXT ITEM]

20.)  Click to run Spell Check [Voice Command: CHECK SPELLING]

21.) Click to delete job [Voice Command: DELETE JOB] Note: A job that already has HL7 messages sent
(e.g. Resident Assigned, Sent to MT) cannot be deleted.
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Available Tokens

Accession Number

The Id of the Exam as ordered in the RIS
(e.g. 79856566)

Body Part

The body part which is associated with the order for the exam
(e.g. ABDOMEN)

Comparisons

ISITE Only. Displays the procedure description, exam date, and
accession number of every comparison exam loaded on the canvas

page

Completed Date

The date the exam was completed in the RIS (also known as the exam
date) in the format m/d/yyyy (e.g. 1/24/1971)

Completed Time

The date/time the exam was completed in the RIS (also known as the
exam date/time) in the format m/d/yyyy h:m a/p (e.g. 1/24/1971 11:30
AM)

Current Time (24h)

The current time in 24h format H:m (e.g. 09:30)

CurrentDate The current date in the format m/d/yyyy

CurrentUser The full name of the user logged in to Fluency Reporting

Gender The gender of the patient. Will be one of M,F,U (e.g. F)

Job ID The Id of the Job which is an incrementing value automatically created

by the Fluency database
(e.g. 42345)

Medical Record Number

Medical Record Number (e.g. 000045678)

Modality

The modality associated with the procedure code for the exam as
defined in the exam code dictionary (e.g. CT)

Ordered Time

The time the order for this exam was placed in the format m/d/yyyy
h:m a/p (e.g. 1/24/1971 11:30 AM)

Ordering Physician

User data field OBR-37 built from OBR-16.++

Patient Birth Date

The patient’s date of birth in the format m/d/yyyy

Patient Class

The type of patient. Will be one of | (inpatient), E (emergency), O
(outpatient) (e.g.))

Patient Name

The name of the patient in the form LAST, FIRST Ml (e.g. DOE, JANE B)

PatientAge

The current age of the patient at the time of the exam (e.g. 43 y/o0)

Procedure Code

The procedure code which is associated with the order for the exam
(e.g. CTABD1)

Procedure Description

The procedure description which is associated with the order for the
exam (e.g.; CT ABDOMEN W CONTRAST)

Radimetrics Dosage

This is the Radimetrics patient dosage

Reason for Exam

The reason the exam was performed as supplied in the order (e.g. MVA)

Scheduled Time

The time exam was scheduled for in the format m/d/yyyy h:m a/p
(e.g. 1/24/1971 11:30AM)

Status

The current RIS status of the exam. Will be one of the A, D, P, F, X, C

Subspecialty Code

The subspecialty Code which is associated with the order for the exam
(e.g. BODY)

Updated Time

The time the order for this exam was last updated in the format
m/d/yyyy h:m a/p (e.g. 1/24/1971 11:30 AM)
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RIS (RADIOLOGY INFORMATION SYSTEM)

Understanding your Home workspace
O Log in to Epic using the information provided to you on your classroom information sheet.

[0 On the department screen choose UCSD Radiology.

= Hint: UCSD Radiology should be the department you select every time you log in, this
provides access to multiple modalities across the hospital access may be limited if you log
in to departments other than this.

O Once you log in you will be brought to the Imaging Dashboard E this is your Home
Workspace.

&8 Hyperspace - UCS

et W Remind Me & Chart ' Encounter -8
Imaging Dashboard

Neuro MR To Protocol: 110 &) Productivity
Studies signed
Modality 1 day 7 days 30 days
0/ - o - 0

Priorit 1 da T days

Settings

Department Status
'\ nding (Ucsd), MD's reads, today

Peer Review
Read-0/0

Peer Review Due: Sep 1

-Reports Subject to Change-

= Protocol Work List: These reports will only populate if there is a protocol to complete.
The protocols are organized into categories. Ex: Neuro Mr., RIS Chest CT, etc....

= Productivity Reports: These reports are an easy way for you to track your productivity
without leaving your home workspace. This report will show you information on the
following. How many studies you signed/your section signed in the past 1,7, and 30 days.
It will also show you your study turnaround time for Routine and High priority exam for
the past 1 day 7 days and 30 days.

= Department Status Report: This report will show you how many total reads you have
completed today as well as total overall count of reads for the day.
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Understanding Integration

00 Integration is a tool implemented on your reading stations that will automatically launch the
patients chart information in Epic when opening the images from PACs.

=  Epic will automatically launch the Study Review activity pictured below corresponding to
the patient selected in your Visage window.

MRI Chest W/O Contrast Order #: 126493011 Accession #: 50000870
Demographics

Amy Radiant Female 57 year old

BACON FLAVOR, CHICKEN-DERIVED PRODUCTS, CEPHALOSPORINS, IDOXURIDINE, IODINE, LATEX

Dx: Pain [R52 (ICD-10-CM)]

Hypertension

Care Team %
Roohian, Arshia Z, MD PCP - General

ian Assistant (Uci), PA

Finding documentation from a Technologist

0 Documentation/Notes entered by the technologist will appear for your review in the Study
Review report.

Order requenc End
bosentan (TRACLEER) tablet 125 mg EVERY 12 f32017 1015 (none)
HOURS
R Oral
ymount: 1 tablet (1 = 125 mg tablet)
5. Inpatient
bosentan (TRACLEER) tablet 62.5 mg EVERY 12 33120170930  (none)
HOURS
Oral
yimount: 0.5 tablet (0.5 = 125 mg tablet)
Inpatient

Study Notes %
Radiology, Tech (Ucsd) on &/4/2017 11:00 AM
Test
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Viewing Patient Information
O Within Epic click on the button on the Hyperspace toolbar.
O Patient: Deanna
0 Search for the Deanna patient on your classroom information sheet.

O You will be brought to the Snapshot report by default, this is an area that summarizes the
patients chart. (Problem List, Allergies, Medications, Health Maintenance, etc....)

00 Click on Chart Review.
= Hint: Use the tabs to review Labs, Imaging studies, past procedures, Notes)
O If you're looking for specific information, search the chart.

= Enter a search term, such as "protocol”, in the field in the upper-right corner of the
screen.

Writing a note on a patient from Protocol Work List.
O Loginto Epic
0 Access your protocol work list using the links from your imaging dashboard.
O With the patient selected click the IR Protocol button in your toolbar. |Rcﬁsun

00 Once in the patient’s chart choose the progress note activity.

00 Within the note are, use smart text or free text to enter the necessary note. Once complete, Click
Accept.

O Sign the Visit by accessing the Sign Visit activity once all other documentation is completed.

O Click Sign Visit.
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Protocol upcoming exams

Completing an Protocol

Scenario: You notice that you have a pending protocol link appearing on your Imaging Dashboard
when you log in to Epic. You will use the link to access the various protocol categories to complete
the pending protocols.

O Open the Protocol Work List.

= On the Imaging Dashboard, click the Outpatient CT Body to Protocol link.
O Find your patient and review the protocol Work List report.
00 Complete the protocol using the smart form button options.

= Hint: The choices made on the smart form will auto populate the details in the protocol
section of the Smart form. (Contrast and Route are automatically included in the
protocols)

= Changes or additions to this can be specified in the Additional instructions sections DO
NOT by modify the protocol section. (Technologist are trained on looking in the
Additional Instructions section for modifications)

0O You have completed your protocol and specified any modifications in the Additional instructions
box, Mark the protocol as Finalized.

= Hint: If the only options available to you are Accept and Restore verify that the Finalize
protocol setting is selected.

ke e
- VS.
IG Route protocol I [Murse Review B fccept | Restore

O Notice the Protocol is now off your Protocol Work List.

Finding and Changing a Protocol

Scenario: You access your protocol work list and are unable to locate the patient that the tech asked
you to protocol.

O From your top toolbar (Hyperspace Toolbar) Click on the Update Protocols button. update Profocals ~
[0 Search for the patient name in the Patient name/ID field.
O Once in the Update protocols area, update the protocol as needed.

O When finished mark as finalized.
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Update protocol information

O Youremember that you forgot to add additional details to a Protocol you just completed and
wish to access the finalized protocol to update it.

O Access your protocol work list.

&

Recent Protocols

O Within the activity click Recent Protocols.
O Locate the protocol that you need to update. Click Update.
[0 Update the protocol as needed.
O Finalize the protocol.

= C(lick Finalize.

Update protocol information

Scenario If necessary the need for a protocol can be cleared by the Radiologist, if you have
determined that a study does not require a protocol mark the study as No Protocol needed by
following the instructions below.

0 Access your protocol work list
00 With the study selected, Click No Protocol.

How Technologist see the information documented by a Radiologist

0o When you document details within the protocol to relay to the performing it will appear to the
technologist in the tech details report and in order details area.

Report-  Tech Details

Order #: 126492762 Accession #: 50000847

Protocol Summary Protocol History |f Diagnosis Radiantone, Zzzepic [80001101] Female 36 year old Currentas of 08/17/17 0933
Protocolled on 8/7/2017 3:49 PM by Jin, Yudi Dx: Voodoo death [R99 (ICD-10-CM)] Height Weight BMI NPO Status
Protocol CTA Cardiac Morph Left Atrial Not recorded Not recorded Not recorded Not recorded
Appendage Labs
Protocol PR-NAME=21CTA cardiac morph Last B e AT
left atrial appendage st Creatinine. JOHEXOL Not recorded
PR-CATEGORY=CTC |Last GFR:
PR-START CastGer
ATEET2 oot TBIL: Anesthesia Type
0 To Gall Praviders
Includes: CTA of the hear, [¢At the time that the onder was placed): Not recorded
optimized for left atrial appendage =
plus delayed phase through LAA Exam Details

Main indications: Left atrial

Performed Proced:
appendage closure (Lariat and Cerent Code] Status erormed Frocedure
Watchman procedure) This patient does not have a recorded code status. Please follow your CT Chest With Contrast
Notes organizational policy for patients in this situation
~place IV for administration of IV Appoiniment Date/Status Recent Event Modality Department
Contrast, remavs \|Vu‘rmr 0 Lines with Linked Medications 8/7/2017  Completed Imaging Complete HC CT SCANNER ROOM C1 HCH CT

ischarge if outpatient = =
“peripheral IV gauge, contrast dose No Linked Lines Found 5
and tate por BMI chart Allergy History as of 081717
~KVp and mA per BMI chart |OHEXOL
1o NTG, no beta-blocker =
_cardiacgating per protocol sheet Noted Status Severity ype Reaction
-CTA coverage: main pulmonary 08/11/17 0825 Jin, Yudi 08/0717 Active High Anaphylaxis
artery through heart 1855 Jin, Yudi 0810717 Deleted High Anaphylaxis
~recon all phases by 5% intervals - k
08/07/17 0853 Jin, Yudi 08I07TMT  Active High Anaphylaxis

If you have time: Review a patient's chart while completing a protocol
O Open the Protocol Work List.

0 Open Chart Review for a patient. Click Chart.
0 Review the patient's chart.
= Use the Snapshot Activity.

= Enter "imaging" in search field in the upper right of your screen. Radiant tip sheets can
also be found on the UC San Diego Pulse website:
https://pulse.ucsd.edu/departments/EMR/ResourcelLibrary/Pages/Radiant.aspx
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ISCHEMIC STROKE CARE AND VIZ. Al APPLICATION

UCSD will be transitioning from IschemiaView (RAPID) to Viz.ai to provide real-time, multi- dimensional
access to hyper-acute imaging, CTP analysis, mobile access and augmented LVO detection. Given that
we have ED, In-house, and Telemedicine cases (that require rt-PA and NIR), communication between
teams has been fragmented, and requires immense attention from the coordinating team to notify all
parties in a timely manner. Viz.ai has a communications pathway included in the implementation that
will allow for easy communication between teams, allowing full teams notification.

Brett C. Meyer, MD is the Co-Director of the UCSD Stroke Center. Click on the link below to launch his
Powerpoint presentation for Viz.ai and its use at UCSD.

Viz App
Presentation.pptx
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